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1. Introduction 

About Gait3D_v1 

Gait3D is a three-dimensional motion analysis program developed for the 
U.S. Army Research Institute of Environmental Medicine (USARIEM). 
The current version is VI.0. It supports the test setup of USARIEM 
motion analysis system with one force plate and fourteen markers. 

Gait3D allows running, visualizing and analyzing multiple gait tests in a 
simple graphical layout. It uses the inverse dynamics and graphical 
routines developed by Shen and Stuhmiller ' and can be customized for 
various test setups. 

Features 

♦ Input and output file formats are compatible with the current 
USARIEM gait program 

♦ Supports running multiple tests in one project 

♦ Provides easy control of analysis parameters 

♦ StickViewer allows the visualization of each test 

♦ XYViewer allows the study of test results inside the program 

Installation 
To install Gait3D_vl, run the install_gait3d_vl.exe program comes with 
this manual. Follow the directions in the installation window. Enter the 
name of the directory where Gait3D_vl to be installed ($gait3dpath) 
when asked for. The installation program will automatically generate 
shortcuts under window startup/program menu and on the desktop. 

To uninstall Gait3D_vl, run the unwise.exe program under the 
$gait3dpath directory. Some files in the directory may need removing 
manually. 

Start Gait3D_v1 

Gait3D_vl can be run from shortcuts under window startup/program 
menu and on the desktop. 

1 Shen, W. and J. H. Stuhmiller (2000), "Articulated Human Biomechanical 
Modeling Toolbox, Phase I Report" 
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2. Program Layout 

Window Convention 

♦ Window Color: the color scheme in Gait3D_vl is the same as the 
default window color 

♦ Window icons: each window or popup window has three buttons at the 
top right corner. Clicking the left icon will minimize the window; 
clicking the middle one will maximize the window; while clicking the 
right one will destroys the window 

♦ Resize windows or panels: most graphical components in Gait3D_vl 
can be resized. At the cornet of certain windows, there are areas that 
can be pulled to increase or decrease the size of the window. For 
window comes with more than one view areas {Project Editing and 
Test Editing Panel, Help Panel, etc.), the vertical or horizontal bar 
separating the view areas can be dragged to change the size of each 
view area. 

♦ Disabled GUI components: Gait3D_vl will automatically enable or 
disable some GUI components during its execution. 

GUI components 

Title bar 

When a project is open, project name will be displayed on the Title bar 

) GAIT PROGRAM: [D:\GaitProoramWeisiorfl\EHample\PiojUsarnple.proi]     PHiTB 

Project Menu 

Project Menu performs operations on a project, such as creating a new 
project; opening an existing project; saving as another project; closing a 
project; running the project, as well as exiting the Gait3D_vl program. 
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) GAIT PROGRAM: 

Project   lest   View 

Hew Pfoject 

Open Project 

Save as Project 

Close Project 

Run Project 

Exit 

Test Menu 

Test Menu performs basic operation on a test, such as adding; importing; 
or deleting a test to or from the project; changing the sequence of the tests 
in the project; as well as changing the default test setting. 

Test   View   XrViewer   ; 

Add 

import 

Move up 

Move down 

fielete 

Default test setting 

View Menu 
View Menu switches between different view panels. The displayed view 
panel will be "checked on". 

View   XYV'iewer    St 

</ Project Editor 

XY Viewer 

Stick Viewer 

Message 

Help  

Toolbar 

The Toolbar provides easy ways of switching between different view 
panels as well as running a project. 
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GUI components 

Switch on/off 
Project/Test 
Edit Panel 

Switch on/off 
XVUiewer Panel 

Switch on/off 
message panel 

pi Project ^ line i'/se XYview | f Sticks l(j) Message) Q Help 

Swtch on/off 
StickUiewet* Panel 

Switch on/off 
Help Panel 

Run analysis of 
the project. 
Enabled only when 
the project has 
been saved 

Project and Test Editing Panels 

Project and Test Editing Panels can be activated by selecting Project 
from View Menu or by clicking the Project icon on the Toolbar. 

Project 
Editing 
Panel 

Separating                           Test 
bar                                         Editing 

Panel 

PROJECT<sample> TEST: [S1p1t2l 

Test Sets InfoFäe                    | DAGaitProgramWersbn1\Example\lnpijt\S1p1   Browse 
lbip<in *-1 Test Name              [sipi(2 ■ylFiW^M 
S1p1t1 

Add      I     Import Delete    | 

Test Type                 ARIEM_FPL1MRKU                                              rj 

Raw Data 

Kin- Fäe                   | O:\GaitPrograrnVVersion1SEKampleMnpiit\S1p1   Browse] 

Force File                | D:\GaitP 

Options 

ogramWeisionl\E:-;arnple\lnpiji\S1 pi   Browse 

for processing raw data 

Analysis Option 
Resampling Rate 

Fz Threshold 

J7   Isolate one strkte? 

Parameters 

1101 

| 50 

p   Blend Stride? 

1              Advanced Options             | 

Output 

CSVfile                    | D:\G.3ifPrcigrarnVvei:siori1\Example\Pion\S1p1   Riowx-J 

PLTfile                    | D:\GaitProgramVveioiori1\ExarnplR\p[0|1'.S1p1   Biowe 

Up Down Default 
GRAfile                     j D:\GaitPrGgramWemon1\EKample\Pioi1\S1p1   Browse) 

Save         |                              Cancel       j Save         j Close 

Project Editing Panel contains a listbox listing all tests in the project; 
an Add button to add a test to the project; an Import button to import a 
test into the project; a Delete button to remove a test from the project; an 
Up and a Down button to change the sequence of tests in the project; and 
a Default button to change the default test setting. It also contains a 
Save and a Close button to save the changes to the project and to close 
the project. 
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Test Editing Panel contains GUI items associated with specifying a 
test. It also contains a Save and a Cancel button to save or discard the 
changes to the test. 

The separating bar between Project Editing Panel and Test Editing 
Panel can be dragged to change their sizes. 

XYViewer 
XYViewer is activated by selecting XYViewer from View Menu or by 
clicking the XYViewer icon on the Toolbar. 

Refer to section 4 for more information on XYViewer. 

StickerViewer 

StickerViewer is activated by selecting StickerViewer from View 
Menu or by clicking the StickerViewer icon on the Toolbar. 

Refer to section 5 for more information on StickerViewer. 

Message View Panel 

MESSAGES 

** OPEN PROJECT b (D:\GaitProgramWersionl\Example\Projl\b.proj) on 28-Dec- 

»» RUN PROJECT  (D:\GaitProgram\Versionl\Example\Projl\b.proj) on 28-Dec-20 

>> RUN TEST [Slpltl] 
PRE-PROCESSING ... 

Reading kinematics data file D:\GaitProgramWersionl\Example\Input\ 
Reading force data file D:\GaitProgramWersionl\Example\Input\Slplt—' 
Filter raw force data (2nd order butterworth filter; cutoff=100 Hz) 
Calculate center of pressure 
Isolate a single stride from kinematics data 
Resample raw data at 101 uniform points 

MODEL SETUP 
Read model info from D:\GaitProgramWersionl\MdlLib\ariem_fpllmrkl4 
Model parameters ... 

1. Total Mass     64.3 (kg) 
2. Pack Mass      13.2 (kg) 
3. Height 1.667 (m) 
4. Shoulder ¥idth 0.376 (m) 
5. Hip Width      0.336 (m) 

Kinematics reconstruction 
KINEMATICS ANALYSIS ... 
DYNAMICS ANALYSIS ... 
SAVE RESULT ... 

iL J 
Close Clear Message 

Message View Panel is activated by selecting Message from View 
Menu or by clicking the Message icon on the Toolbar. 

Message View Panel displays information regarding to the project and 
test operations. 
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GUI components 

Help View Panel 

Help View Panel is accessed by selecting Help from View Menu or by 
clicking the Help icon on the Toolbar. 

Help View Panel lists topics regarding Gait3d_vl. Click on a topic to 
view the contents of the topic in the content listbox. A + or a - to the left of 
a topic indicates subtopics are present under the topic. Double clicking on 
the topic will display or hide the subtopics. 

The separating bar between Topic window and Content window can 
be dragged to change their sizes. 

TOPICS -z 
Program Layout 

Menus 
Toolbar 
View Panels 

-Run Analysis 
Files 
Edit a Project 
Edit a Test 
Run Project 

-Use XYviewer 
About XYviewer 
Gui Components 
Open/Close Data 
Plot Data 
Edit 
Export 

-Use Stickviewer 
About Stickviewe: 
Gui Components 
Open/Close Dot« 
Plot Data 
Edit 
Export Movie 

Example 

J 
Close 

About Gait3D_vl 
Gait3D is a three-dimensional notion analysis program developed 
for the U.S. Army Research Institute of Environmental Medicine 
(USARIEM). The current version is VI.0. It supports the test se 
of USARIEM motion analysis system with one force plate and 
fourteen markers. 

Gait3D allows running, visualizing and analyzing multiple gait 
tests in a simple graphical layout. It uses the inverse dynamic 
and graphical routines developed by Shen and Stuhmiller 
and can be customized for various test setups. 

Features 
» Input and output file formats are compatible with the current 

USARIEM gait program 
* Supports running multiple tests in one project 
» Provides easy control of analysis parameters 
* StickViewer allows the visualization of each test 
* XYViewer allows the study of test results inside the program 

Installation 
To install Gait3D_vl, run the install_gait3d_vl.exe program 
comes with this manual. Follow the directions in the installati 
window. Enter the name of the directory where Gait3D_vl to be 
installed ($gait3dpath) when asked for. The installation progra 
will automatically generate shortcuts under window startup/prog  
menu and on the desktop. 

To uninstall Gait3D_vl, run the unwise.exe program under the 
Sgait3dpath directory. Some files in the directory may need 
removing manually. 

Start Gait3D_vl 
Gait3D_vl can be run from shortcuts under window startup/progra 
menu and on the desktop. 

J 
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3. Run Analysis 

File Associated with a Project 

Project file (*.proj) 
A project file is a binary file stores all information regarding a project. A 
project file always has the name of projname.proj, where projname 
indicates the name of the project. 

Message file (*.msg) 
A message file is an ASCII file with the name of projname.msg in the 
same directory as the project file. It records all operations performed on 
the project, including those performed during previous use of Gait3d_vl. 
This file has to be removed manually when not needed or become too 
large. 

Output file (*.output) 
After a project is run, an ASCII file named projname.output will be 
generated automatically in the same directory as the project file. It 
contains detailed information on each test being analyzed. 

Default test setting file (test.default) 
When a new project is created, Gait3D_vl will automatically create the 
file test.default in the same directory as the project file. This file records 
the default test setting associated with the projects in the directory. It 
will be updated when default test setting is changed in Gait3D_vl. 

File Associated with a Test 

The two-dimensional test setup of USARIEM motion analysis system with 
one force plate and fourteen markers, labeled as ARIEM_FPL1MRK14, 
is currently supported. Files associated with this kind of test are listed as 
follow. 

Input files 
Two input files: testname.vid and testname.tad are required for a test. 
These files are output from USARIEM motion system. They should have 
the same name (except for different file extensions) and be in the same 
directory. The format for these files, as described by previous USARIEM 
gait software manual, is given as follows 

3-1 



Run Analysis 

testname.vid is the video "marker" file that contains 3D coordinates. It is 
expected to contain 60 columns of data (20 3D markers). Columns filled 
with zeros represent unused markers. If the number of markers is odd, 
the 13th marker is assumed to be from the pack, with "extra" markers 
beginning with marker #14. Otherwise, a no-pack condition is detected 
and extra markers begin with marker #13. Thus extra markers must be 
added only in multiples of two. 

The total body center of gravity (CG) data always fills the last three 
columns of the marker output file, or in some cases, a copy of hip data is 
used to substitute total body CG. 

testname.tad is the force plate file that contains the measured ground 
reaction force and EMG signals when present. 

Test info file 

When a test is created or edited in Gait3D_vl, a test info file 
testname.info will automatically be created in the same directory as the 
test input files. It is file is only for saving the test information, which can 
be input into other projects when necessary. 

Table 3-1. Test information saved in a test info file 

Motion Data 

Sampling rate of motion capture system 

Filter type and cutoff frequency for raw marker data 

File name of the *.vid file 

Force Plate/EMG 
data 

Sampling rate of motion capture system 

Filter type and cutoff frequency for raw marker data 

File name of the *.tad file 

Number of pre-trigger samples. This is used to 
remove the initial data shift of the force plate 

Parameter 

Total mass 

Pack mass 

Subject height 

Subject hip width 

Subject shoulder width 

Result Files 
Three result files will be created in the same directory as the project file 
for each test when a project has been analyzed. 
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Run Analysis 

testname.grf is an ASCII spread sheet file containing the time history of 
all results. This file follows exactly the same format as the output file 
format of the previous USAREIM gait software. 

testname.plt is an binary result file containing the time history of all 
results. This file can be opened by XYViewer in Gait3D. 

testname.gra is an binary result file for creating stick plot. This file can 
be opened by StickViewer in Gait3D. 

Edit a Project 

Create a new project 

♦ Select New Project from Project Menu 

♦ Browse for or enter the name of the new project 

After a new project is created, Gait3D automatically switches to Project 
and Test Editing Panels 

Open an existing project 

♦ Select Open Project from Project Menu 

♦ Browse for the project to be opened 

After the projected is opened, Gait3D automatically switches to Project 
and Test Editing Panels. 

Save the current project as a new project 

♦ Select Save as Project from Project Menu 

♦ Browse for or enter the name of the new project 

Close the project 

♦ Select Close Project from Project Menu 

Or click on Close button on Project Editing Panel 

After a project is closed, Gait3D automatically switches to Message 
Panel. 

Save changes to the project 

♦ Click on Save button on Project Editing Panel 

Gait3D_vl can automatically detect if changes have been made to the 
current project. If no change has been made, the Save button is disabled. 
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Run Analysis 

Add a new test to the project 

♦ Click on Add button on Project Editing Panel 

♦ In the popup window, browse and select the motion data file 
associated with this test. 

♦ The Project Editing Panel will be "locked", and the Test Editing 
Panel will be update to show the default value for the new test 

♦ Edit the test (see below on Editing a test) and click Save button on 
the Test Editing Panel to add the test to the project 

Or click Cancel on the Test Editing Panel to abort adding the test. 

Note: The new test will use the default test setting. In order to let all new 
test to have the desired default value, edit the default test setting first. 

Import a test to the project 

♦ Click on Import button on Project Editing Panel 

♦ In the popup window, browse and select the test info file associated 
with the test to be input. 

Note: Only the test information as specified in Table 3-1 will be imported. 
The remaining test data will use the values in the default test setting. 

Remove a test from the project 

♦ Select the test in the Test listbox on Project Editing Panel 

♦ Click Delete button on Project Editing Panel 

Change the sequence of tests in the project 

♦ Select a test in the Test listbox on Project Editing Panel 

♦ Click Up or Down button on Project Editing Panel to move the 
test up or down 

Change the default test setting 

♦ Click Default button 

♦ The Project Editing Panel will be "locked", and the Test Editing 
Panel will be update to show the current default setting 

♦ Edit the default value (refer below on Editing a test) and click 
Update default button on the Test Editing Panel to change the 
test default setting 

Or click Cancel on the Test Editing Panel to abort the change. 
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Run Analysis 

Edit a test (ARIEM_FPL1MRK14 type) 

Select a test 
Click on a test in the Test Listbox in the Project Editing Panel will display 
information related to the test in the Test Editing Panel and allows it to be edited. 

Changes to a test 
When any change is made to a test, the Project Editing Panel will be "locked". 
Project Editing Panel can only be released after the changes have been saved 
(click on Save button in Test Editing Panel) or is discarded (click on Cancel 
button in Test Editing Panel). 

Note: An unsaved test is indicated by an * after test name in the Test Editing 
Panel 

Edit Test information 

Table 3-2. Basic test information (saved in a test info file) 

Item GUI to edit the 
item Default Value 

Sampling rate of motion capture system Options to 
process raw data 
button 

60 

Filter type and cutoff frequency for raw 
marker data 

2nd order 
butterworth;0 

File name of the *.vid file Browse button N/A 

Sampling rate offeree plate data Options to 
process raw data 
button 

1000 

Filter type and cutoff frequency force data 2nd order 
butterworthjlOO 

File name of the *.tad file Browse N/A 

Number of pre-trigger samples. This is used 
to remove the initial data shift of the force 
plate 

Options to 
process raw data 
button 

100 

Total mass 

Parameters 
button 

70 

Pack mass 15 

Subject height 1.8 

Subject hip width 0.336 

Subject shoulder width 0.376 

Table 3-3. Analysis related test information 
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Run Analysis 

Item 
GUI to edit the 

item Default Value 

Test type Disabled 
ARIEM FPL1M 
RK14 

Re-sampling rate (for analysis and output) Resample Rate 
box 

101 

Threshold for vertical ground reaction force Fz threshold box 50 (N) 

Whether isolate one stride from test data disabled Always on 

Whether blend the start and end of a stride Blend stride check 
box 

off 

Output grf file name disabled testname.grf 

Output pit file name disabled testname.plt 

Output gra file name disabled testname.gra 

Gravity vector Advanced Option 
button 

0 0 -9.8037 

Various filter type and cutoff frequency for 
kinematics analysis 

Advanced Option 
button 

2nd order 
butterworth;10 

Run a Project 

♦ Select Run Project from Project Menu 

Or click the Analyze icon on Toolbar 

♦ Gait3D_vl will automatically switch to Message View 

♦ The project will start running with an popup window indicating the 
progressing of the project 

Note: A project must be saved before it can be run. An unsaved project is 
indicated by an * after project name in the Title bar  
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4. XY Plot Viewer 

About XYViewer 

What is XY plot viewer 

XYViewer is graphical viewer to visualize the vectors or matrices stored 
in JIF ASCII files or STDMAT binary files. 

Features 

♦ Support STDMAT and JIF ASCII file formats, where the value of each 
"channel" of data is stored in a column vector and associated with a 
name, label, units. In STDMAT files, the data channels can also be 
grouped under different group names; 

♦ Multiple data files can be opened in the same viewer. This allows the 
comparison of data from different files; 

♦ Support printing the plot as PS, EPS, EMF, and BITMAP files; 

♦ Support outputing plot data as space, tab or comma delimited ASCII 
files; 

♦ A simple GUI layout allows the easy access and plotting of data; 

♦ Support overlay of curves on a single plot; 

♦ Easy access to data definition and peak values; 

♦ Many axis properties, such as color, grid, box, legend, axis label, title, 
can be edited; 

♦ Many line properties ,such as style, width, color, marker and marker 
size, can be edited; 

♦ Automatically synchronized with additional data viewer, such as 
stickViewer, to visualize data on fly. 

GUI Components 

This section describes several GUI components of XYViewer and their 
common use. 

XY Plot Axis 

XY Plot Axis is where the data is plotted. 
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: XY Plot Viewer 

J XY VIEWER 

XWiewef 
QsS 
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XYViewer Menu 

The XYViewer Menu performs file operations, such as opening and 
closing of data files, as well as printing and exporting of a plot. 

J XY VIEWER 

J XYViewer 

Open Data File 
Close Data File 

Print Plot ► 
Export Pbt        ► 

XYViewer Toolbar 

XYViewer Toolbar provides easy access to common operations: 
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XY Plot Viewer 

Show 
Open print plot 
data pi0t control 
file 

clear 
plot 

axis 
option 

csieiflEsi *üfF\ei s 

Close Exp0rt 
data plot 

file 

show 
legend quick 

help 

ouerlay 
plot 

Axis Property Context Menu 

Axis Property Context Menu is launched by right clicking mouse 
inside the XY Plot Axis but not over any curve plotted inside. It provides 
options to edit the properties of the axis. 

Show plot control 

• Overly curves 

Clear curves 

Axis range 

Title & label 

• Legend on 

£dit legend 

Grid on 

• Box on 

Background Color 

Foreground Color 

Use Default 

Line Property Context Menu 

Line Property Context Menu is activated by right clicking mouse over 
a curve inside the XY Plot Axis. It provides options to edit line 
properties of the curve selected. 
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: XY Plot Viewer 

f k 

1 
line style ► 

line äiidth ► 

line color 

marker ► 

marker size 

filter i 

shift and scale 1 

delete 

-SB—B- 

XY Plot Control 

XY Plot Control is a popup window that displays the file(s) being opened 
and data inside a selected file. It can be used to open or close data file(s) 
and to plot data. 

J XY Plot Control 

DATA FILES 

1\ExampfcAs1p1t2.plt .ff   Add | Deletej 

X-DATA GROUP 

Time X stride 
MARKER 
GRF 
BODY-Foot 
BODY-Shank 
BODY-Thigh 
BODY-Forearm 
BODY-UpperArm 
BODY-Head d 

X-VARIABLE 

Y-DATA GROUP 
Time 
Time % stride 
MARKER 
GRF 
BODY-Foot 
BODY-Shank 
BODY-Thigh 
BODY-Forearm 
BODY-UpperArm 
BODY-Head zl 

Y-VARIABLE 

d 

A-lin-Foot-x 
A-lin-Foot-z 
P-ang-Foot-y 
V-ang-Foot-y 
A-ang-Foot-y 

d 
Help Cancel Plot 
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Use XY Plot Viewer 

Use XY Plot Viewer 

Open/Close XY Data File 

To open a data file, follow the following steps 

♦ Select Open Data File from XYViewer Menu; 

or push the Open Data File button on XYViewer Toolbar; 

or push the Add button inside XY Plot Control 

♦ Browse for the file to open in the popup File Browse Window 

To close a data file, follow the following steps 

♦ Select Close Data File from XYViewer Menu; 

or push the Close Data File button on XYViewer Toolbar; 

or push the Delete button inside XY Plot Control 

♦ Select the file(s) to close in the popup Close XY plot data files 
window and click Remove button to close the data file(s). 

} Close XY plot data files 

Select data files to close: 

D:\GaitProgramWersion1 \Example\s1 p11 * 

^ 

Select all 

Remove        |  Cancel | 

Print/Export a Plot 

To print a plot on the XY Plot Axis, follow the following steps 
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: XY Plot Viewer 

♦ Select Print Plot from XYViewer Menu; 

or push the Print button on XYViewer Toolbar; 

♦ Select Default Printer to print to the default printer 

♦ Select the type of file and enter the file name in the popup file 
browser window to print the plot as a file. Current the following 
types of files are supported 

♦ Postscript files(*.ps) 

♦ Encapsulated postscript files (*.eps) 

♦ Window meta files (*.emf) 

♦ Bitmap files (*.bitmap) 

To export the curves plotted in the XY Plot Axis to an ASCII file, follow 
the following steps 

♦ Select Export Plot from XYViewer Menu; 

or push the Export button on XYViewer Toolbar; 

♦ Select the type of file and enter the file name in the popup file 
browser window to export the data. Current the following types of 
files are supported 

♦ Space/tab delimited ASCII (*.dat) 

♦ Comma delimited ASCII files (*.csv) 

♦ JIF ASCII files (*.jif) 

Plot Data 

Following the following steps to plot data 

♦ Activate the XY Plot Control. This can be done by doing one of the 
following: 

♦ Push Show XY button on XYViewer Toolbar; 

♦ In Axis Property Context Menu (by right click mouse in the XY 
Plot Axis), select Show Plot Control; 

♦ Push Axis Properties button on XYViewer Toolbar and select 
Show Plot Control; 

♦ Select the right data file in the Data File popup window 

♦ In X Data Group listbox, select the group name of X-axis variable 

♦ In X Variable listbox, select the X-axis variable 

♦ In Y Data Group listbox, select the group name of Y-axis variable(s) 

♦ In Y Variable listbox, select the Y-axis variable(s) 

♦ Click the Plot button to plot the selected Y-variable(s) vs. X-variable. 
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Use XY Plot Viewer 

Edit Axis Properties 

♦ Activate the Axis Property Context Menu by doing one of the 
following: 

♦ Push Axis Properties button on XYViewer Toolbar; 

♦ Right click mouse in the XY Plot Axis. 

♦ Select one of the following properties to edit 

♦ Axis range 

♦ Title & Label 

♦ Legend on 

♦ Edit legend 

♦ Grid on 

♦ Box on 

♦ Background color 

♦ Foreground color 

Edit Line Properties 

♦ Activate the Line Property Context Menu by right clicking mouse 
over the curve whose properties is to be edited 

♦ Select one of the following properties to edit 

♦ Line style 

♦ Line width 

♦ Line color 

♦ Marker 

♦ Marker size 

Show/Hide Legend 

The legend for the curves plotted can be displayed or removed from XY 
Plot axis by one of the following 

♦ Push Legend on/off button on XYViewer Toolbar; 

♦ Or select Legend on/off in Axis Property Context Menu (by right 
click mouse in the XY Plot Axis) 

Enable/Disable Overlaying Plots 

Overlaying plot can be enabled or disabled by one of the following 

♦ Push Overlay curve button on XYViewer Toolbar; 
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: XY Plot Viewer 

♦ Or select Overlay curves in Axis Property Context Menu (by 
right click mouse in the XY Plot Axis) 

Clear a Plot or Delete a Curve 

One of the following will clear the plot 

♦ Push Clear button on XYViewer Toolbar; 

♦ Or select Clear curves in Axis Property Context Menu (by right 
click mouse in the XY Plot Axis) 

To delete only one curve from the plot, follow the following steps 

♦ Activate the Line Property Context Menu by right clicking mouse 
over the curve whose properties is to be deleted 

♦ Select Delete 

Get Quick Help 
To get quick help and information about XYViewer, 

♦ Push Help button on XYViewer Toolbar; 

♦ Select a topic to display the help message about the topic 
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5. Stick Plot Viewer 

About StickViewer 

What is Stick plot viewer 

StickViewer is a three-dimensional viewer to visualize stick plots. 

Features 

♦ Simple GUI provides easy access to visualization and animation 

♦ Support printing the plot as PS, EPS, EMF, and BITMAP files; 

♦ Support outputing stick animations as Matlab movies; 

♦ Many axis properties, such as color, grid, box, legend, axis label, title, 
can be edited; 

♦ Many stick properties ,such as style, width, color, marker and marker 
size, can be edited; 

♦ Automatically synchronized with XYViewer to visualize data on fly. 

GUI Components 

This section describes several GUI components of StickViewer and their 
common use. 

Stick Plot Axis 

Stick Plot Axis is where the data is plotted. 
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Stick Plot Viewer 

i stick VIEWER 

Stick Viewer 
HE 

G*I0isä oas !3>l 

M-I«l.„:l 

X 

Time: 074(36/101) 

1 1\9\ 

StickViewer Menu 

The StickViewer Menu performs file operations, such as opening and 
closing of data files, as well as printing plot and exporting animation. 

> stick VIEWER 

Stick Viewer 

Open Stick Graphics File 

Close Stick Graphics File 

Print Plot 
Export Movie 

StickViewer Toolbar 
StickViewer Toolbar provides easy access to common operations: 

Axis 
Open   Print 3D       property 
data   plot    rotate

P 

file 

aOT#l£l 

Close Export 
data movie 
file Uiew 

angle 

Quick 
help 
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Stick Plot Viewer 

Stick Animation Toolbar 

Stick Animation Toolbar provides options to control the animation of 
stick plots. 

Scrollbar 

Stop  Back Foruard 

Axis Property Context Menu 

Axis Property Context Menu is launched by right clicking mouse 
inside the Stick Plot Axis but not over any stick. It provides options to 
edit the properties of the axis. 

</ Axis equal 

Axis on 

View Angle 

Show Title & label 

</ Box on 

Background Color 

Foreground Color 

Use Default 

Stick Property Context Menu 

Stick Property Context Menu is activated by right clicking mouse over 
a stick inside the Stick Plot Axis. It provides options to edit line 
properties of the stick selected. 
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Stick Plot Viewer 

Use STICK Plot Viewer 

Open/Close Stick Graphics File 

To open a data file, follow the following steps 

♦ Select Open Stick Graphics File from StickViewer Menu; 

or push the Open button on StickViewer Toolbar; 

♦ Browse for the file to open in the popup File Browse Window 

♦ The first frame of the stick plots will be displayed 

To close a stick graphics file, follow the following steps 

♦ Select Close Stick Graphics File from StickViewer Menu; 

or push the Close button on StickViewer Toolbar; 

Note: Stick graphic file is a Matlab binary data file containing the time 
history of positions and orientations of each stick, as well as the definition 
of each stick  

Print a Frame 

To print a snapshot of a stick plot frame the following steps 

♦ Select Print Plot from StickViewer Menu; 

or push the Print button on StickViewer Toolbar; 

♦ Select Default Printer to print the snapshot to the default printer 

♦ Select the type of file and enter the file name in the popup file 
browser window to print the snapshot as a file. Currently the 
following types of files are supported 

♦ Postscript files(*.ps) 

♦ Encapsulated postscript files (*.eps) 

♦ Window meta files (*.emf) 

♦ Bitmap files (*.bitmap) 

Export an Animation 

To export a stick animation, following the following steps 

♦ Select Export Movie from StickViewer Menu; 

or push the Export button on StickViewer Toolbar; 

♦ Select the type of file and enter the file name in the popup file 
browser window to export the data. Currently only Matlab movie 
(*.mat) is supported 
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Use STICK Plot Viewer 

Note: To convert a Matlab movie file into an AVI file, use "movie2avi" 
command in Matlab  

Edit Axis Properties 

♦ Activate the Axis Property Context Menu by doing one of the 
following: 

♦ Push Axis Properties button on StickViewer Toolbar; 

♦ Right click mouse in the Stick Plot Axis. 

♦ Select one of the following properties to edit 

♦ Axis equal: force all axes to use the same data aspect ratio for 

♦ Axis on: turn on or turn off axis 

♦ View angle: change the view angle of the 3D stick plots 

♦ Show Title & lable: show label for the axes 

♦ Box on: add or remove box from the axis 

♦ Background color: change background of the axis 

♦ Foreground color: change foreground of the axis 

Edit Stick Properties 

♦ Activate the Stick Property Context Menu by right clicking mouse 
over the stick whose properties is to be edited 

♦ Select one of the following properties to edit 

♦ Line style 

♦ Line width 

♦ Line color 

♦ Marker 

♦ Marker size 

Free rotation of Axis 

The free rotation of the axis (to change view angle) can be performed by 
pushing down the 3D rotate button on StickViewer Toolbar and use 
mouse to rotate the Stick Plot Axis. 

Get Quick Help 

To get quick help and information about StickViewer, 

♦ Push Help button on StickViewer Toolbar; 

♦ Select a topic to display the help message about the topic 
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Stick Plot Viewer 
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6. Example 

Files need for the example problem 

During installation, Gait3D_vl creates an Example directory under the 
directory where Gait3D_yl is installed ($gait3dpath). There are four 
subdirectories under the Example directory. 

♦ InputData: contains input motion data files and force plate data files 

♦ OldOutput: contains result files from the previous USARIEM gait 
program 

♦ TestProject: is an empty directory where example project will be built 

♦ Calibrate: contains some matlab routines to compare the result of 
Gait3D_vl with the previous gait program 

Create a new project 

♦ Start Gait3D_vl 

♦ Select New Project from Project Menu 

♦ Browse in the popup window to directory 
$gait3dpathlExamplelTestProject and enter project name as 
Sample 

♦ A new project Sample.proj is created and Gait3D_vl automatically 
switch to the Project and Test Editing Panels 

Note; Sample.msg and test.default are also created in the directory 

Setup test default setting 

♦ Click Default button in the Project Editing Panel 

♦ Click subsequently Options for preprocessing button, Parameters 
button, and Advanced option button in the Test Editing Panel and 
change the values to the desired default values. In this example, 
change the parameters to 64.3 (kg), 13.2 (kg), 1.667 (m), 0.336 (m) and 
0.376 (m) and leave all other variables unchanged. 

♦ Click Update Default button in the Test Editing Panel 

Add tests to the project 

♦ Click Add button in the Project Editing Panel 

♦ Browse in the popup window to directory 
$gait3dpathlExamplelInputData and select Slpltl.vid 
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♦ Click Save button in the Test Editing Panel 

♦ A new test named Slpltl is added to the sample project 

♦ Repeat the step to add more tests (Slplt2, Slp2tl) into the project. 

Run the project 

♦ Save the project by clicking Save button in the Project Editing 
Panel. Sample.proj is created in the project directory. 

♦ Click Analyze icon in the Toolbar to start running the project 

♦ Gait3D_vl will switches to Message View and pops up a Status 
dialog, indicating the progress if the analysis. 

♦ After the analysis is complete, a number of files will be created in the 
project directory, including 

♦ Sample.output: an ASCII file recording details of the analysis 

♦ Three result files for each test, i.e., Slpltl.grf, Slpltl.pltf, 
Slpltl.gra etc. 

Look into Result using XYviewer and StickViewer 

♦ Click on XYViewer icon in the Toolbar to activate XYViewer 

♦ Click on StickViewer icon in the Toolbar to also activate 
StickViewer 

♦ Click the Open icon in the XYViewer 

♦ Browse in the popup window to directory 
$gait3dpathlExamplelTestProject and select Slpltl.plt 

♦ Click the Open icon in the StickViewer 

♦ Browse in the popup window to directory 
$gait3dpath/Example/TestProject and select Slpltl.gra 
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